In order to get the best performance out of Photoshop, you need to ensure that your computer system has been optimized for image editing work. When I first began writing the ‘Photoshop for Photographers’ series of books, it was always necessary to guide readers on how to buy the most suitable computer for Photoshop work and what hardware specifications to look for. These days I would say that almost any computer you buy is now capable of running Photoshop and can be upgraded later to run Photoshop faster. The main thing is to ensure that you have as much RAM memory as possible installed in your machine and fast disk access. This chapter addresses all the other key issues you need to take into consideration.

Configuring Photoshop

By Martin Evening
What you will need

Below is a guide to the minimum system requirements for Macintosh and Windows system computers. The main thing to point out here is that Photoshop CC is now only available as a download and not as a boxed product. It can be purchased by subscription, either as a single product, by subscribing fully to the Creative Cloud, in which case you’ll be able to access all Adobe Creative Cloud products, or by subscribing to the special photography plan that includes Lightroom. The other thing to point out here is that there is now only one version of Photoshop. Those features that were once offered in the Extended version only are now all included in a single version.

Macintosh

Photoshop CC 2018 can only be run on the latest Intel-based Macs running macOS 10.11.0 or later. The minimum RAM requirement is 2 GB (8 GB RAM or more is recommended), plus Photoshop CC requires an estimated 2 GB of free hard disk space to install the program. You will also need a computer display with at least a 1024 x 768 display (1280 x 800 recommended) driven by a 16-bit (or greater) graphics card with at least 512 MB video RAM (1 GB recommended) and an OpenGL 2.0 capable system. All the current range of Apple Macintosh computers are capable of meeting these requirements, although with some of the older Mac Pro computers you may need to upgrade the video graphics card.

Windows

Photoshop CC 2018 can run on Intel Core 2 or AMD Athlon 64 Processor; 2GHz or faster processor running Windows 7 with Service Pack 1 or Windows 10. While it is still possible to install on Windows 8.1, this is no longer recommended by Adobe. The minimum RAM requirement is 2 GB (8 GB or more is recommended) and Photoshop CC requires an estimated 2 GB of free hard disk space to install the 64-bit version of the program. You will also need a computer display with a 1024 x 768 display (1280 x 800 recommended), driven by a 16-bit (or greater) graphics card with at least 512 MB video RAM (1 GB recommended) and an OpenGL 2.0 capable system. Almost any new PC system you buy should have no trouble meeting these requirements.

64-bit processing support

64-bit processing is now the new standard for the latest computer hardware. The key benefit of this is it lets you take advantage of having more than 4GB of RAM memory installed in your computer. This will have the potential to boost the speed for some operations (like the time it takes to open large documents).
The ideal computer setup

Your computer working environment is important. Even if space is limited there is much you can do to make your work area an efficient place to work in. Figure 1 shows a computer setup from a few years ago. Firstly, the walls in this office are painted neutral gray using paint I was able to get from a local hardware store. When dried and measured with a spectrophotometer, I found this paint color to be almost perfectly neutral in color. The under shelf lighting uses cool fluorescent strips that bounce off behind the displays to avoid any light hitting the screens directly. Here, you can see that I had a 30", NEC LCD display hooked up to a tower computer with an internal DVD drive. I had a Wacom graphics pad and pen to work with as an input device and also an external hard drive for backing up data.

Figure 1 This shows what I might regard as an ideal basic Photoshop setup. This features a tower computer with plenty of RAM memory, a high quality calibrated display, a graphics input tablet, a removable backup drive and a UPS device to protect against power surges or cut-outs. The lighting comes from a daylight balanced tube which backlights the display. I usually have the light level turned down quite low, in order to maximize the monitor viewing contrast.
As your requirements grow you will probably need to have more external drives and, if you can afford it, I highly recommend working with two large displays side by side.

It is also important to choose an operator chair that is comfortable to sit in for long periods of time. Ideally you want a chair that has arm rests and adjustable seating positions so that your wrists can rest comfortably on the table top. The computer display monitor should be adjusted so that it is level with your line of sight, or slightly lower.

Once you start building an imaging workstation, you will soon end up with lots of electrical devices. While these in themselves may not consume a huge amount of power, do take care not to have too many power leads trailing from a single power point. To prevent damage or loss of data from a sudden power cut I suggest you place an uninterruptible power supply unit (UPS) between your computer and the mains source. These devices can also smooth out any voltage spikes or surges in the electricity supply (see “Protecting the power supply” on page 21). In Figure 1 the computer and display are both connected to a power supply unit on the right.

Choosing a display

The display is one of the most important components in your computer setup. It is what you will spend all your time looking at as you work in Photoshop and you really don't want to economize by buying a cheap one that is unsuited for graphics use. The only types you can buy these days are liquid crystal displays (LCDs), which range in size from the small screens used on laptop computers to big 30” desktop models.

An LCD display contains a translucent film of fixed-size liquid crystal elements that individually filter the color of a backlit, fluorescent or LED light source. Therefore, the only hardware adjustment you can usually make is to adjust the brightness of the backlit screen. The contrast of an LCD is also fixed, but LCDs are generally more contrasty than CRT monitors ever were, which is not a bad thing when doing Photoshop work for print output.

Because LCDs are digital devices they tend to produce a more consistent color output, but they do still need to be calibrated and profiled of course. Once profiled though, the display’s performance should remain fairly consistent over a long period of time. On the other hand, with some displays there may be some variance in the image appearance depending on the angle from which you view it, which means the color output of an LCD may only appear correct when the display is viewed front on. This very much depends on the design of the LCD display unit and the worst examples of this can
be seen with ultra-thin laptop screens. However, the evenness of output from high quality desktop LCD screens is certainly a lot more consistent these days.

There are two competing technologies for LCD screen displays. For gaming it is best to use a Twisted Nematics (TN) type display, as these offer fast redraw speeds. For image editing it is best to use the slower In Plane Switching (IPS), type display which offers greater consistency of color over a wider viewing angle.

The higher grade LCD screens do feature relatively good viewing angle consistency, are not too far off from providing a neutral color at a D65 white balance, and won’t fluctuate much in performance. As with everything else in life, you get what you pay for.

**Support for 30-bit display output**

Photoshop is able to support 30-bit displays (10-bits per channel) for improved bit-depth viewing, provided that the monitor hardware, the graphic card and operating system, all support 30-bit. If so, Photoshop can render the video data into 30-bit buffers. The latest Windows operating systems are capable of supporting this fully. It is also now an option available to Macintosh users running Mac OS X 10.11 (El Capitan). To enable, you need to check the advanced GPU preferences. This enables 30-bit video support for Photoshop and Camera Raw.

**Video cards**

The graphics card in your computer is what drives the display. It processes all the pixel information and converts it to draw the color image that's seen on the display. An accelerated graphics card can let you to do several things. It can allow you to run your display at higher screen resolutions, hold more image display view data in memory and can use the display profile information to finely adjust the color appearance. When more of the off-screen image data is able to be held in video memory the image scrolling is enhanced and this generally provides faster display refreshes. In the old days, computers would be sold with a limited amount of video memory and if you were lucky you could just about manage to run a small display in millions of colors. These days a computer is likely to be equipped with a good, high performance graphics card that is easily capable of meeting all your needs. A modern video card will typically have at least 512 MB of dedicated memory, which is enough to satisfy the minimum requirements for Photoshop. However, with the advent of the latest video graphics support for Photoshop and Camera Raw, it is now worth considering a video card that can offer faster processing via the graphics processor to support the internal computer's central processor.

**Eizo ColorEdge**

Eizo have established themselves as offering the finest quality LCD displays for graphics use. The ColorEdge CG301 is the flagship model in the range. The 30" wide screen is capable of providing uniform screen display from edge to edge, encompasses the Adobe RGB gamut and comes with ColorNavigator calibration software that can be used with X-Rite calibration devices. This display is more expensive than most, but is highly prized for its color fidelity.
OpenGL and OpenCL

The graphics processor unit (GPU) can often fit more processing into its schedule due to its very high clockspeed. When allowed, it can give up some of its available cycles to help out the central processor unit (CPU) and provide additional processing power. The first implementation of this was OpenGL, where OpenGL enabled cards could share certain graphics tasks (such as zoom and flick panning), thereby freeing up the CPU. Meanwhile, OpenCL does not confine itself to graphics, but can help with any computer-intensive task. Naturally, applications must be written specifically to take advantage of what OpenCL can provide in terms of faster Photoshop processing. If you want to take full advantage of such GPU support, it might be necessary to purchase a new video card. At the time of writing there is a long list of video cards capable of providing faster graphics support in Photoshop CC 2015.5 for Mac OS X 10.9.5 (or later) and support for Windows 7, 8 & 10. Adobe do list the GPU cards that are recommended for Photoshop use, but it is difficult though to point to any one group of cards and say “these are best”. This is because the GPU performance in Photoshop is down to not just the card, but also the computer platform and operating system used as well. Check the Adobe Help site to find out which video cards are designated as being compatible for Photoshop use.

High density displays

The first release of Photoshop CC offered HiDPI Retina support for Macintosh users, which currently extends to compatible PC devices, as Adobe have introduced support for Microsoft’s Surface Pro 3. This development makes Photoshop more responsive and supports pinch and zoom actions.

Essentially, a high density display has twice the usual density of pixels. This gives the user the option of doubling the pixel resolution of the display, but at the expense of everything appearing tiny on the screen (especially user interface designs). However, there are other configurations available you can configure in the system preferences. Ideally, you will want the software enabled for a high density display, where the user interface (UI) icons will need to be designed at twice the usual resolution and thereby result in a smoother UI appearance.

With an image editing program such as Photoshop, high density displays throw something of a curve ball, because how should Photoshop images be displayed? Should they be displayed at the native pixel resolution of the display device where one Photoshop image
pixel is displayed using one high density display pixel. Or, should the image magnification set so that one Photoshop image pixel is displayed using 4 high density display pixels? Add to this the fact that there are people on high density displays who are designing images for non-high density displays and vice versa. Therefore, extra controls are required to manage the difference between what is seen and what is perceived. Plus, we now have to think carefully when we talk about pixel sizes, since in the context of a high density display this can now mean different things. There are implications too for web design layouts, which may require dual resolutions for people visiting a website where a Retina, or high density display is detected. This might be of importance to photographers who wish their portfolio pages to be viewed as optimally as possible.

**High density display support**

Following the introduction of Mac OSX Retina support, the Photoshop interface underwent a significant number of changes in order to support higher resolution screens. These changes affected the traditional 1X scaling, as well as the more dense displays (also known as 2X or HiDPI).

When the minimum display size for Photoshop was made to be 1024 x 768 pixels, this presented a problem for the design of the many Photoshop user interface elements. This was because existing dialogs now had to fit within tighter constraints of 1024 x 768 pixels at x2 pixel density. Many of the Photoshop dialogs (including Camera Raw) plus all the adjustment and filter dialogs had to be revised. Consequently, the layouts are in some instances different to earlier versions of Photoshop, as are the pull-down menus and buttons. In some cases this has meant making some of the traditional Photoshop dialogs more widescreen, changing them from vertical to being horizontal in layout.

**High density display and default zoom settings**

When the system preferences for a high density display are configured so that four high density display pixels equal one display pixel, the Photoshop user interface will appear to be at the same scale as before. However, the user interface elements will appear smoother because they are at a higher pixel density. With this configuration Photoshop opens images so that one high density display pixel equals one Photoshop pixel. However, when opening smaller images this may mean them appearing really tiny on the screen compared to how you would expect them to be displayed.
If you are working with a high density display, your images may be displayed at a much finer resolution than was the case previously and you may wish to quickly change the zoom setting so that four high density pixels equal a single Photoshop pixel. In other words, have a means to quickly switch to a 200% view setting instead of 100%. On all systems you can use a \( \text{CS} \) (Mac), \text{ctrl} (PC) double-click on the zoom tool to go to a 200% zoom view and use a \( \text{CS} \text{Shift} \) (Mac), \text{ctrl Shift} (PC) + double-click on the zoom tool to set all open documents to a 200% view. Whenever the hand or zoom tool are active you will notice that the context menu includes a 200% view option (see Figure 2) and in the Options bar the Actual Pixels button has been renamed ‘100%’ so as to avoid any confusion (see Figure 3). Lastly, there is now a 200% option in the View menu and you can also assign this with a custom keyboard shortcut should you wish.

![Figure 2](image.png) The zoom tool context menu now includes 100% and 200% zoom options.

![Figure 3](image.png) This shows the Photoshop CS6 crop tool Options bar (top) and the CC Options bar (bottom). Here, the ‘Actual Pixels’ button has been replaced by a “100%” button. You will notice that the Print Size button has been removed (although it is still available as a View menu item).

**Display calibration and profiling**

We now need to focus on what is the most important aspect of any Photoshop system: getting the display to show your images in Photoshop correctly and ensure that the display colors can be relied upon to match the print output. This basic advice should be self-evident, because when we work in Photoshop we all want our images to be consistent from session to session and match in appearance when viewed on another user’s system.

The initial calibration process should get your display close to an idealized state. The next step is to build a display profile that describes how well the display actually performs after it has been calibrated, which at a minimum describes the white point and chosen gamma.

The more advanced LCD displays such as the Eizo ColorEdge and NEC Spectraview do provide hardware calibration for a more consistent and standardized output, but the only adjustment you can make on most LCD displays is to adjust the brightness. Some may allow you to adjust the RGB colors, but these controls are best left alone.
Calibration hardware

Let’s now look at the practical steps for calibrating your display. First, get rid of any distracting background colors or patterns on the computer desktop. Consider choosing a neutral color theme for your operating system. If you are using a PC, go to Control Panels ➞ Appearance & Personalization ➞ Window Color and Appearance. I then suggest you choose the Graphite theme and adjust the Color Intensity slider as desired. This is all very subjective of course, but personally I think these adjustments improve the look of both operating systems.

The only reliable way to calibrate and profile your display is to use a hardware calibration system. Some displays, such as the LaCie range can be bought with a bundled hardware calibrator, but there are many other types of stand-alone calibration packages to consider. The ColorVision Spyder4 series are affordable and are sold with the software needed to perform a display calibration. More expensive is the basiCCoolor Discus (though much recommended by some experts). Colorimeter devices can only be used to measure the output from a display. Unlike the more expensive spectrophotometers, you can’t use them to measure print targets, but when it comes to profiling a display they are just as good.

The X-Rite product range includes the i1 system, which is available in several different packages. The i1 Pro 2 (Figure 5) is an emissive spectrophotometer that can measure all types of displays and build printer profiles too when used in conjunction with X-Rite, or other calibration software (such as basiCCoolor). Also in the X-Rite range, is the ColorMunki Photo, which is an integrated calibration/profiling device that can work with everything, including LCD beamer projectors.

If all you are interested in is calibrating and profiling a computer display, there is no great advantage in choosing a spectrophotometer over the more economically priced colorimeter devices. Whatever you do, I certainly advise you to include a calibrator/software package with any display purchase.

Adding a second display

To run a second display you may need to buy an additional video graphics card that will provide a second video port. You’ll then be able to contain all the Photoshop panels on the second screen and keep the main display area clear of clutter.

The calibration/profiling procedure

Over the next few pages I have shown how to use the basiCCoolor software with an X-Rite i1 calibration device. Other calibration software packages will differ of course, but the basic principles should be similar to other software programs. Also, check out the special offer from Colourmanagement.net at the back of the Photoshop for Photographers book, who are a distributor for basiCCoolor.
1 An uncalibrated and unprofiled display cannot be relied on to provide an accurate indication of how colors should look. Many displays default to using an over-bright luminance setting.

2 The calibration process simply aims to optimize the display for brightness and get the luminance within a desired range.

3 The profiling process takes into account the target white balance and gamma. The profiling process also measures how a broad range of colors are reproduced on the display. These will appear one at a time, ready to be measured by the device.

4 To create a profile of this kind you need a suitable colorimeter device plus appropriate software. There are a number of devices that can be used to do this, such as the i1 Display Pro from X-Rite. Once calibrated and profiled, you will have a computer display that can be relied upon when assessing how your colors will reproduce in print.
White point

The white point information tells the video card how to display a pure white on the screen so that it matches a specific color temperature. Unlike the old CRT displays, it is not possible to physically adjust the white point of an LCD screen. For this reason, it can often be better to select the native white point option when calibrating an LCD display (as shown in Step 2 on page 14), rather than calibrate to a prescribed white point value. Remember that all colors are seen relative to what is perceived to be the whitest white in a scene and the eye naturally compensates from the white point seen on the display to the white point used by an alternative viewing light source.

There is a lot of seemingly conflicting advice out there on how to set the white point in a calibration setup. In the days when CRT displays were popular there was a choice to be made between a 5000K and a 6500K white point for print work. My advice then was to use 6500K, since most CRT displays would run naturally at a white point of 6500K, although some people regarded 5000K as being the correct value to use for CMYK proofing work. In reality though, the whites on your display will appear more yellow at this setting, especially when working with ambient daylight coming into the room. 6500K may be cooler than the assumed 5000K standard, but 6500K has proved to be much better for image editing viewing. These days, most LCD displays have a native color temperature that is around 6000–7000K and it is also considered OK to choose the native white point when calibrating and profiling an LCD display, especially if the native white point is fairly close to a 6000K or 6500K target.

The main thing to remember here is that your eyes adjust quite naturally to the white point color of any display, in the same way as your eyes constantly adjust to the fluctuations in color temperature of everyday lighting conditions. Therefore, your eyes will judge all colors relative to the color of the whitest white, so the apparent disparity of using a white point for the display that is not exactly the same as that of a calibrated viewing lightbox is not something you should worry about. As I say, when it comes to comparing colors, your eyes will naturally adapt as they move from the screen to a viewing lightbox.

Gamma

The gamma setting tells the video card how much to adjust the midtone levels compensation. You sometimes have just three options to choose from here: 1.8, 2.2 or Native Gamma. Quite often you are told that PC users should use 2.2 gamma and Macintosh users should use 1.8 gamma. But 2.2 can be considered the ideal gamma setting to
use regardless of the system you use. If you like you can build a correct
display profile using a 1.8 gamma option, but 2.2 is closer to the native
gamma of most displays. In fact, you’ll often be recommended to
select the ‘Native Gamma’ option at this point. If you choose ‘native’
you can create a satisfactory display profile without forcing the video
card to stretch the display levels any more than is necessary. However,
when using the basICColor software you can select the L* option.
The technical reason why this is recommended is because L* uses the
luminance tone axis as prescribed in the Lab color space – it’s better
because it more closely matches human perception and provides a
more linear gray axis.

Note that the gamma you choose when creating a display profile
does not affect how light or dark an image will be displayed in
Photoshop. This is because the display profile gamma only affects how
the midtone levels are distributed. But the gamma setting will affect
the appearance in other non ICC-savvy programs. Whether you use
a Mac or PC computer, you should ideally choose the Native gamma,
Gamma 2.2, or L* (as shown in the following steps). It is also important
to allow the display to warm up first for around 5 minutes or so after
being just switched on or woken up from sleep.

Luminance

You need to make sure that the brightness of the LCD display is
within an acceptable luminance range. The target luminance will vary
according to which type of display you are using. A typical modern
LCD display will have a luminance of 250 candelas per m² or more
at its maximum luminance setting, which is way too bright for image
editing work in subdued office lighting conditions. A target of around
120–140 candelas per m² is ideal for a desktop LCD display. For laptop
computers, the ideal luminance to aim for is around 100–110 CD/m².

It’s important to note that as displays get older they tend to lose
brightness, which is one of the reasons why you’ll need to use a
calibration device to recalibrate the display from time to time. There
may also come a point where the display becomes so dim that it can
no longer be successfully calibrated or considered reliable enough for
Photoshop image editing.
The profiling process

When you click on the Start button (see Step 5), the software will start flashing a series of colors on the screen, while the calibration device measures these. Once completed this will generate a new profile, ready for use as the new display profile, replacing the previous one. You might also want to set a reminder for when the next monitor profile should be made. With LCD displays, regular calibration is not quite so critical and it will probably be enough for you to profile the display once a month. Also, do you really need to hang on to your old display profiles? I recommend that you purge the Colorsync Profiles folder on your system of older display profiles to avoid confusion. All you really need is one good, up-to-date profile for each display.

Do you want good color or just OK color?

Let me summarize why you should pay special attention to how your images are displayed in Photoshop and why good color management is essential.

These days the only real option is to buy a good quality LCD display that is designed for graphic use. Once you have chosen a good display you need to consider how you are going to calibrate and profile it. This is crucial and if done right it means you can trust the colors you see on the display when determining what the print output will look like. In the long run you are going to save yourself an awful lot of time and frustration if you calibrate and profile the display properly right from the start. Not so long ago, the price of a large display plus a decent video card would have cost a small fortune and display calibrators were considered specialist items. These days, a basic display calibration and profiling device can cost about the same as the purchase of a couple of external hard drives, so I would urge anyone setting up a computer system for Photoshop to put a display calibrator and accompanying software package high on their spending list.

All the display calibrator products I have tested automatically place the generated display profile in the correct system folder so that you are ready to start working straight away in Photoshop with your display properly calibrated and with the knowledge that Photoshop automatically knows how to read the profile you have just created.

Is the display too bright?

These days, some LCD displays can be way too bright for digital imaging work. Brand new LCD displays do lose their brightness after a 100 hours or so of use, which may make them more usable. However, some of the new glossy displays appear to be incapable of revealing detail in the extreme highlight range. The thing is, these types of displays may look great for playing video games and watching TV, but they are not ideal for image editing work.
1 This first screen asks you to establish which type of display you wish to calibrate and profile. With this particular software you can click the ‘Express’ button to create a suitable display calibration, or click ‘Next’ to configure the settings manually.

2 To begin with I set the white point to ‘Monitor’s Native’. You could choose a target setting such as D65, but native is usually best for an LCD display.
3 Next, I set the target gamma to L* (as recommended by the basiCColor software). In some cases you might want to select ‘Gamma 2.2’, or ‘Native Gamma (if available). iMac displays are probably better off being calibrated using gamma 2.2.

4 In the Luminance section I set the Maximum luminance to 120 candelas per m². You might want to opt for a setting of 140 CD/m² if working in a bright room environment.
Color management settings

One of the very first things you should do after installing Photoshop is to adjust the color management settings. The default Photoshop Color Settings are configured using a general setting for the region you live in, which will be: North America, Europe or Japan. If you are using Photoshop for design work or photography, you will want to change this to a regional ‘prepress’ setting. Go to the Edit menu and select Color Settings, which opens the dialog shown in Figure 6. Next, go to the Settings menu and select one of the prepress settings. The individual prepress settings only differ in the default RGB to CMYK conversions that are used, and these will depend on the geographical area you are working in. If you live and work in the US, choose North America Prepress 2 and you will mostly be fine with that setting. Please note that choosing a prepress setting changes the RGB working space from sRGB to Adobe RGB. This is a good thing if you intend editing RGB photographs in Photoshop (although I would personally recommend using ProPhoto RGB). The prepress settings also adjust the policy settings so as to preserve embedded profiles and alert you whenever there is a profile mismatch. I would also suggest you turn off

Eyeball calibration

Another option is to use a non-device calibration method, such as the Display Calibration Assistant that is part of the Mac OS X operating system. This is better than doing nothing, but is still no substitute for proper hardware calibration and profiling. If you don’t invest in a calibration/measuring device, your only other option is to load a canned profile for the display and keep your fingers crossed. This approach is better than doing nothing but rarely all that successful, so I would still urge you to consider buying a proper calibration device and software package.

5 Having named the profile, I clicked the Start button. The software then measured a sequence of colors flashed up on the display and from this built an ICC profile. This would be automatically saved to the correct system folder and picked up by the system and referenced by Photoshop’s color management system.
the ‘Ask When Opening’ option in the Profile Mismatches section. This minimizes the number of times you are shown the profile mismatch warning dialog when working with image files that are in different color spaces. When you customize the color settings presets in this way, the preset menu will say ‘Custom.’ I suggest that you then save and name this preset so that these settings are easy to access in future.

Once this is done, the Color Settings will remain set until you change them. After that, all you need to worry about is making sure that the calibration and profile for your display are kept up-to-date. If you follow these recommended steps you won’t need to worry too much more about the ins and outs of Photoshop color management until you are ready to. If you would like to learn more about the color management in Photoshop please refer to the Color Management chapter in the book. Color management does not have to be intimidatingly complex and nor does it have to be expensive. So the question is, do you want good color or simply OK color? Or, to put it another way, can you afford not to?

Figure 6 The Photoshop Color Settings. All the Photoshop color settings can be managed from within this single dialog (Shift K [Mac] Ctrl Shift K [PC]) and shared with other Creative Suite applications (see Figure 7).
Color managing the print output

This leaves the question of how to profile the print output? Getting custom profiles built for your printer is a good idea, and it is a topic that I have covered in some detail in the Color Management PDF (available from the book website). However, calibrating and building a profile for your display is by far the most important first step in the whole color management process. Get this right and the canned profiles that came with your printer should work just fine. Follow these instructions and you should get a much closer match between what you see on the display and what you see coming out of your printer, although without doubt, a custom print profile will help you get even better results.

Synchronizing the Color Settings

If you are using other programs that are part of the Adobe Creative Suite, such as Illustrator and InDesign, it is a good idea to keep the Color settings synchronized across all of these programs (see Figure 7). Once you have selected a desired color setting in Photoshop, I suggest you open Bridge and synchronize the Color Settings there too. This ensures that the same color settings are used throughout all the other programs in the Creative Suite.

Chip speed

Microchip processing speed is expressed in GigaHertz, but performance speed also depends on the chip type. A 3 GHz Pentium class 4 chip is not as fast as a 3 GHz Intel 6-Core Intel Xeon processor. Speed comparisons in terms of the number of megahertz are only valid between chips of the same series. Many of the latest computers are also enabled with twin processors or more, although having extra cores is mainly beneficial when running certain types of filter operations. Another crucial factor is the bus speed, which refers to the speed of data transfer from RAM memory to the CPU (the central processing unit, i.e. the chip). CPU performance can be restricted by slow system bus speeds, so faster is definitely better, especially for Photoshop work where large chunks of data are being processed. More recently, Photoshop has sought to take advantage of OpenGL (and now OpenCL) enabled video cards to speed up some aspects of Photoshop’s image processing.
Extras

An internal 16× or faster DVD/CD drive has often been fitted as standard in most computers, although in recent years some computers no longer feature these as standard. Devices such as a graphics tablet, external hard drive and other peripheral devices can be connected using one of the following interfaces.

USB is a universal interface connection for Mac and PC. The older USB 1 connection was regarded as being very slow, but the newer USB 2 and USB 3 interface connections are faster, especially for those working on a PC system. You can have up to 127 USB devices linked to a single computer. FireWire (also known as the IEEE 1394 interface) has the potential to provide fast data transfer rates of 49 MB per second (faster still using the FireWire 800). Apple also has, in conjunction with Intel, a new proprietary interface called Thunderbolt, which offers data transfer speeds of up to 20 Gbits/s. It allows for both hard drives and displays. It can also carry audio and when coupled with OpenCL and Open GL, points the way to an overall increased performance. Of all these, USB 3 is the more universal and offers suitably fast data speeds for Photoshop work when reading and writing files to a disk.

Graphics tablets

I highly recommend you get a digitizing graphics tablet like the one shown in Figure 8. This is a pressure sensitive device, which makes it easier to draw with, and can be used alongside the mouse as an input device. Bigger is not necessarily better though. Some people like using the A4 sized tablets, while others find it easier to work with an A5 or A6 tablet. You don’t have to move the pen around so much with smaller pads and these are therefore easier to use for painting and drawing.

Figure 8 Wacom™ pad and pen.
Once you have experienced working with a pen, using the mouse is like trying to draw while wearing boxing gloves! The latest Wacom Intuos™ range now features a cordless mouse with switchable pens and the Wacom Cintiq™ device is a combination of LCD monitor and digitizing pen pad. This radical new design introduces a whole new concept to the way we interact with the on-screen image. I don’t know if it is going to be generally seen as the ideal way of working with photographs, but there are those who reckon it makes painting and drawing a more fluid experience.

**Backing up your image data**

The Mac and PC operating systems encourage you to place all your image files in the users ‘Pictures’ or ‘My Pictures’ folder. This might work fine if all you are shooting are JPEG snaps, but it is unlikely to suffice once you start capturing lots of raw images. So your first consideration should be to store your image files on hard drives that have plenty enough capacity to anticipate your image storage needs for at least the next year or two. The next thing you need to consider is how accessible is your image data? Suppose a power supply unit failure or some other glitch prevented you from turning on the computer? For this reason I find it is helpful to store important image data on drives that can easily be accessed, or removed. One solution is to store your data on separate internal hard drives where the drive caddies can easily be swapped over to the internal bay of another computer. Or, you can store the data on external hard drive units that can simply be plugged in to another computer.

The next thing is to implement a backup strategy for your images and other important data files. For each main hard drive you should have at least one matching sized external hard drive that you can regularly back up the data to. These hard drives should be kept somewhere safe so that in case of a fire or theft you have access to recently backed up versions of all your essential data. Another suggestion is to have two external backup drives for each main drive. That way you can swap over the backup drives and continually have a secondary backup version stored permanently off-site, or kept in a fire proof safe.

During Photoshop’s lifetime we have seen many different storage systems come and go: floppy disks, Syquests, Magneto Opticals… the list goes on. Although you can still obtain devices that are capable of reading these media formats, the question is, for how long? What will you do in the future if a specific hardware device fails to work? The introduction of recordable CD/DVD media has provided a reasonably consistent means of storage and for the last 20 years nearly all computers have been able to read CD and DVD discs. DVD drives
have also evolved to provide much faster read/write speeds and DVD media may be able to offer increased storage space in the future. We are already seeing bigger disc media storage systems such as Blu-ray Disc. So how long will CD and DVD media remain popular and be supported by future computer hardware devices? More to the point, how long will the media discs themselves last? It is estimated that aluminium and gold CD discs could last up to 30 years, or longer, if stored carefully in the right conditions such as at the right temperature and away from direct sunlight, while DVD discs that use vegetable dyes may have a shorter life-span. I wouldn't bet on DVD or Blu-ray media providing a long-term archive solution, but even so, I reckon it is worth keeping extra backups of your data on such media. The one advantage write once media has over hard drive storage is that your data is protected from the prospect of a virus attack. If a virus were to infect your computer and damage your data files, a backup procedure might simply copy the damage over to the backup disks.

Protecting the power supply

It is inevitable that you will at some point suffer an interruption to the power supply. There is at least an option to enable background saving, which can at least mitigate the worst consequence of a power failure: the loss of everything you have just been working on. Even so, it is not a good idea to let the computer be affected by a sudden loss of power or power surge. I therefore suggest you purchase a suitable Uninterruptible Power Supply Unit (UPS). You need to make sure that the unit you buy can handle the power demands of at least the main computer, display and powered hard drives. In my office I have my main computer setup powered via an APC Back-UPS ES-700 unit.

Vampire power

Have you ever stopped to think how much electric power your computer workstation consumes, and of that how much is wasted? The statistics are quite alarming. Countries around the world have come up with different statistics, but it is estimated that between 7% and 13% of residential power is consumed by household appliances being left on standby mode. Of course, some of those items, such as security alarm systems, have to be left on standby mode full-time. In a typical office it is possible to accumulate a large number of electrical items, especially all the power bricks that are used to power individual hard drives and other computer accessories. It’s a real problem and one that I have only partially managed to resolve by copying the data from a lot of my external drives onto bigger, single drive units and connecting all the lesser-used appliances to a switchable power strip.

Cloud storage

Cloud computing, including cloud storage, is becoming more widely used these days. Most photographers tend to have storage requirements that run to at least several gigabytes and cloud storage is something that is often thought of as both pricey and slow. However, with plans to deliver broadband speeds at ever higher rates, we should see this becoming more of a realistic proposition for professional users.
Photoshop preferences

The Photoshop preferences are located in the Edit menu in Windows and the Photoshop menu in Mac OS X and these let you customize the various Photoshop functions. A new preference file is generated each time you exit Photoshop and deleting or removing this file will force Photoshop to reset all of its preference settings. The preference file is stored along with other program settings in the system level Preferences folder: Users/Username/Library/Preferences folder (Mac) or C:\Users\Username\App Data\Roaming\Adobe\Adobe Photoshop CC 2015.5\Adobe Photoshop CC 2015.5 Settings folder (PC). If you are unable to locate the users folder this may be because the most current Mac and PC systems opt to hide the inner workings, such as user system folders. On Mac OS X, in the Finder, hold down the alt key and mouse down on the Go menu. This reveals the user’s Library folder. Once found, it’s a good idea to create a shortcut for future use. On Windows 8, go to the Control Panel and choose ‘Appearance and Personalization’. In the following dialog go to ‘Folder Options’ and click on ‘Show hidden files and folders’. This will offer options that allow you to control which items remain hidden.

Resetting the preferences

After configuring the preference settings I suggest you make a duplicate of the Photoshop preference file after you have closed Photoshop and store it somewhere safe. Having ready access to a clean preference file can speed up the resetting of the Photoshop settings should the working preference file become corrupted. Also, If you hold down ⌘ Shift (Mac), ctrl alt Shift (PC) during startup cycle, this pops a dialog box that allows you to delete the current Photoshop preference file. This is useful if you are having problems with Photoshop’s performance and you reckon the current preference file is the cause of the trouble.

Force updating the preferences

Once you have configured your preferences and got everything set up just the way you want and ensure these Preferences are applied, quit and restart Photoshop. This forces Photoshop to save these preferences as it updates the preference file.
General preferences

When you open the preferences you will first be shown the General preferences (Figure 9). I suggest you leave the Color Picker set to Adobe (unless you have a strong attachment to the system Color Picker). Photoshop has a HUD (Heads Up Display) Color Picker with options for selecting new colors when working with the eyedropper or paint tools (Figure 10). When any paint or fill tool is selected, you can hold down the `COL` keys (Mac), or hold down the `ALT Shift` keys and right-click (PC), to open the Heads Up Display Color Picker. These are available in different sizes from the HUD Color Picker menu. Note that the HUD Color Picker is only accessible when the Graphics Processor Settings are enabled (see page 47). The default now in the Image Interpolation menu is Bicubic Automatic. If you need to override this setting you can always do so via the Image ➤ Image Size dialog.

In the main Options section, ‘Auto-Update Open Documents’ can be used if you know you are likely to share files that are open in Photoshop but have been updated by another application. This used to be important when ImageReady was provided as a separate Web editing program to accompany Photoshop, but has less relevance now and can be left switched off. Uncheck the ‘Show “Start” Workspace

![Figure 9](image.png) The General preferences dialog.
When No Documents Are Open’ if you wish to keep this hidden. Checking ‘Use Legacy “new Document” Interface’ can be used to disable the new style New Document dialog and revert to the old one. Check ‘Skip Transform when Placing’ if you don’t need to see the Transform bounding box to adjust the placed image scaling.

Only check the ‘Beep When Done’ box if you want Photoshop to signal a sound alert each time a task is completed.

If you need to be able to paste the Photoshop clipboard contents to another program after you exit Photoshop then leave the ‘Export Clipboard’ box checked. Otherwise, I suggest you switch this off. When the ‘Resize Image During Place’ preference item is checked, if you use File ➢ Place… to place a photo in a document that is smaller than the placed image, the placed file is placed in a bounding box scaled to the dimensions of the target image. ‘Always Create Smart Objects when Placing’ allows you to drag a Photoshop compatible file directly from the Finder/Explorer or from Bridge to place it as a new layer in an open document.

You will often come across warning dialogs in Photoshop that contain a ‘Don’t Warn Me Again’ checkbox. If you have at some stage clicked in these boxes to prevent a warning dialog appearing again you can undo this by clicking on the ‘Reset All Warning Dialogs’ button in the General preferences. If you click on the ‘Reset Preferences on Quit’ button this will pop a dialog warning this will reset all preferences. It is a useful option if you are confused and want to reset everything to the default settings again.

Figure 10 The Heads Up Display Color Picker. The two main heads up display options are the Hue Strip (middle) and the Hue wheel (right).
Interface preferences

The Interface preferences are shown in Figure 11. The Photoshop interface can be customized, allowing you to choose from one of four different panel brightness settings. These range from a light gray theme that is not too different from the previous ‘classic’ Photoshop interface, to three progressively darker themes. This is something that I discuss in the following section, where I point out how important it is to change the default interface settings in order to establish a suitable interface brightness and canvas color for photo editing work. Next to this is the Highlight Color menu where you can choose between the Default gray and new Blue Highlight Color options (see the examples in Figure 12).

The outer canvas areas can be customized by selecting alternative colors from the Color menus. You can also adjust the border, which can be shown as a drop shadow, thin black line, or with the border style set to ‘None’.

Figure 11 Interface preferences.

Color Theme Easter egg

If you **Shift+Alt**-click the Color Theme swatches you can temporarily make these display as bread icons!
Text user interface settings

The Text section allows you to choose an alternative UI language (if available) and UI Font size. The default UI Font size setting is ‘Small’ (10pt), which some users may find plenty big enough. However, more and more people are these days using large, high resolution LCD displays, which are only really designed to operate at their best when using the finest resolution setting. This can be great for viewing photographs, but the downside is that the application menu items are getting smaller and smaller. Therefore, the UI Font Size option allows you to customize the size of the smaller font menu items in Photoshop so that you don’t have to strain your eyes to read them. For example, when using a large LCD screen, the Medium (11pt) or Large (12pt) font size option may make it easier to read the smaller font menu items from a distance.

It should also be pointed out here that the font size is consistent between the Mac and Windows platforms. The UI scaling menu is enabled if a high pixel density display is detected. This allows you to control how the Photoshop user interface is displayed on such devices.

Options section

The ‘Show Channels in Color’ option is a somewhat redundant feature as it does not really help you visualize the channels any better. If anything it is a distraction and best left unchecked. Photoshop allows you to create custom menu settings and use colors to highlight favorite menu items, but this particular feature can be disabled by unchecking the ‘Show Menu Colors’ option. The ‘Dynamic Color Sliders’ option ensures that the colors change in the Color panel as you drag the sliders, so keep this checked.

Figure 12 The Default Highlight Color option (top) and Blue Highlight Color option (bottom).
User interface brightness

Photoshop CS6 saw the introduction of a new interface design, which offered newly-designed panels and icons and also four color themes with different levels of brightness. You can adjust the program's appearance via the Interface preferences shown in Figure 11 (and again in Figure 17). With macOS 10.13 and newer, Photoshop displays a dark title bar for floating document windows when the user interface brightness is set to one of the two dark settings.

Having the ability to adjust the brightness of the interface has to be a good thing. But, having said that, you do need to decide carefully which setting is right for the kind of work you do. By default, Photoshop uses a dark color theme and Figure 13 shows an example of how the Layers and Histogram Photoshop panels look when this is selected. Now, dark themes can look quite nice when they are implemented well. For example, in my view the Lightroom interface is a good example of a dark user interface design. But the thing to be aware of here is that the dark default setting in Photoshop isn't particularly easy to read, especially if you are working on a large display where the panel lettering can appear quite small (more of which later). More importantly, the default canvas color is linked to the interface brightness setting. In the case of the dark default, it's almost completely black and this can certainly lead to problems when editing photographic images because how we perceive tone and color is very much dependent on what surrounds the image.

To show you what I mean, take a look at the photograph in Figure 14. Do you think it looks OK? Now compare this with the Figure 15 version. Does it still look the same when viewed against white? Actually, I adjusted these two versions of the photograph separately using a Curves adjustment to obtain what I thought looked like the best-looking result, first against the black background and then against white. You can see a comparison of these two versions, both displayed against a neutral gray background (Figure 16). The black canvas background edited version is on the left and the white canvas background version is on the right. Do they still look the same to you? As you can see, although these image views each looked fine when viewed against a black or white background, when you compare them side by side, you can see that the canvas color choice has quite an impact on how the image is perceived when making those all-important tone adjustments. This highlights the fact that the canvas color can greatly affect the edit decisions we make.
What you have to understand here is that Photoshop is a program that's used by a wide variety of customers. For example, those who work with video will find a dark interface works well for them. This is because the work they produce is intended to be viewed in dark surroundings. Photographers on the other hand will primarily be interested in the way their photographs will look when printed, which is most likely to be against a paper white background.

Regardless of whichever interface theme you think looks nicest, I strongly recommend you customize the Photoshop canvas color to make it suitable for photo editing work. To do this, choose Photoshop ➔ Preferences ➔ Interface… (Mac), or Edit ➔ Preferences ➔ Interface… (PC). This opens the dialog shown in Figure 17, where, if you go to the Standard Screen, Full Screen with Menus and Full Screen options you can click on the pop-up menu and choose an appropriate canvas color. If you would like to match the previous Photoshop canvas color, I suggest you choose the Light Gray option. Do this for each menu and click OK.

**Figure 16** Here, you see how the image views shown in Figure 14 and Figure 15 looked when compared alongside each other using the ‘Light Gray’ canvas color. Black is on the left and white is on the right.

**Figure 15** This shows the same image shown in Figure 14, but curves adjusted while viewed against a white canvas.
The other thing to consider is the legibility of the interface. Figure 18 shows a quick comparison of the different interface brightness settings. If you compare the Photoshop CC panel design with that used in CS5, you'll notice that the separation between the panels is less distinct and the panel lettering doesn't stand out so well. This isn't helped by the 'dark wash' effect as you select darker themes. The top row in Figure 16 shows examples of the four main brightness themes in Photoshop CC ranging from the lightest to the darkest. In the bottom row, the bottom left example shows how these same panels looked when viewed in Photoshop CS5. Next to this I selected the second darkest theme from the top row and captured this using the default small UI font size, next to it the medium UI font size and lastly, the large UI font size.

It seems to me that the lack of tone contrast in the overall interface tends to make the panels blend together. However, there are things you can do to further tweak the interface. You can adjust the UI font size (see Figure 17), although any changes you make here won't take place
until you relaunch Photoshop. As you can see in Figure 18, increasing the font size marginally increases the overall size of the panels, but certainly makes the lettering stand out more clearly. Throughout the book I mainly captured the screen shots using the medium light gray theme with a medium UI font size. I chose this combination to ensure the screen shots remained legible. I know from experience that dark UI screen shots can be notoriously difficult to reproduce well in print.

**Figure 18** This shows a comparison of the different interface options.
Workspace preferences

The Workspace preferences are shown below in Figure 19. In the Options section. The 'Auto-Collapse Iconic Panels' option allows you to open panels from icon mode and auto-collapse them back to icon mode again as soon as you start editing an image, while 'Auto Show Hidden Panels' reveals hidden panels on rollover.

When the 'Open Documents as Tabs' option is checked, new documents will open as tabbed documents, docked to a single document window in the Photoshop workspace. Uncheck this if you prefer the floating document window opening behavior.

When the 'Enable Floating Document Windows Docking' option is checked, you can drag one window to another as a tabbed document. Check Large Tabs to make the panel tabs bigger. This can be useful if working with a touch display by making the tabs more accessible.

Align UI option

Windows 10 users who are using a device paired with a stylus can access a 'Align UI According to OS Settings' option. This can be used to avoid having contextual UI items such as popup menus show up under your hand while you are drawing directly on the display. The OS settings can be accessed via the Ink & Stylus system preferences.

Figure 19 The Workspace preferences.
The ‘Enable Narrow Options Bar’ option is disabled by default. If you choose to enable and restart Photoshop, all check boxes and radio buttons in the Options bar will instead be displayed using Widgets (see Figure 20). The reason for this is to make the Options bar more visible for users who are working with localized versions of Photoshop on smaller displays.

**Figure 20** Here you can see above, the standard Options bar and below it a narrow Options bar. In this example, the ‘Show Transform Controls’ check box has been replaced by a widget. You can roll the mouse over to see a helpful reminder.

### Tools preferences

The Tools preferences are shown in Figure 21. When ‘Show Tool Tips’ is checked a tool tips box will appear for a few seconds after you roll
over various items in the Photoshop interface. Tool tips are an excellent
learning tool, but they can become irritating after a while, so you can
use this checkbox to turn them on or off as desired.

If the ‘Use Rich Tool Tips’ option is also checked, this lets new
users explore Photoshop without having to leave the program (see
Figure 22). The Rich Tool tips show animated content that helps
explain the function of each selected tool.

The ‘Enable Gestures’ option is relevant if you are using a laptop
computer or have a trackpad device connected to your computer.
One of the things you can do with a trackpad is to set it up to respond
to specific finger gestures. But this can be both a good or a bad
thing: some users have found it rather distracting when carrying out
Photoshop work and prefer to switch this option off.

The ‘Use Shift Key for Tool Switch’ option answers the needs of
those users who wish to disable using the $Shift$ key modifier for
switching tools in the Tools panel with repeated keystrokes. This
can help speed up your workflow when pasting lots of documents,
especially now that Photoshop allows you to drag and drop Photoshop
compatible files to place them in an image.

If the ‘Overscroll’ option is enabled it means that when you are
working in a regular document window, you now have the ability to
overscroll the image to reveal the outer canvas area. Otherwise you can
only do this while in one of the full screen view modes.

The ‘Enable Flick panning’ option is discussed in Chapter 1 in
the book. This again is dependent on OpenGL being enabled for this
option to take effect.

Checking ‘Use Legacy Healing Algorithm for the Healing brush’
reverts to the previous healing brush algorithm. Since the current
implementation is more effective I recommend this be left unchecked.
Check ‘Double Click Layer Mask Launches Select and Mask
Workspace’ so you have another option to switch to this workspace. I
cover Select and Mask in detail in Chapter 8 of the book.

The ‘Vary Round Brush Hardness on HUD Vertical Movement’
determines what happens when you have a painting tool selected and
you hold down the $ctrl$ keys (Mac), or the $alt$ key and right-click
(PC) and drag. When this option is checked, dragging up or down
varies the round brush hardness. When it is deselected, dragging up or
down varies the brush opacity instead.

‘Snap Vector Tools and Transforms to Pixel Grid’ does just what
it says. When ‘Show Transformational Values’ is checked you get to
see the heads up display that you will have seen in some of the book’s
screen shots for things like the marquee tools.
The ‘Zoom with Scroll Wheel’ option lets you zoom in and out using the scroll wheel on a mouse, or your two-finger gestures on a Trackpad. When this option is selected, holding down the Shift key makes the zoom operate quicker. Instead of selecting this option, you can also hold down the Alt key to temporarily access the zoom wheel behavior. Note that if you do check the ‘Zoom with Scroll Wheel’ option, this may also affect track pad gestures. For example, Mac computers make no differentiation between a mouse scroll wheel movement and a two-finger motion gesture on a track pad. It may therefore be preferable to uncheck this if using the track pad for more straightforward navigation around an image, where inadvertent zooming would be annoying.

The ‘Animated Zoom’ option is another OpenGL only option, which is intended to provide smoother transitions on screen when using the Z (Mac), Ctrl- (PC), or Z (Mac), Ctrl+ (PC) keys to zoom in or out. Also, check the ‘Zoom Resizes Windows’ option if you want the image window to shrink to fit whenever you use a keyboard zoom shortcut such as Z (Mac), Ctrl- (PC) or Z (Mac), Ctrl+ (PC).

When the ‘Zoom Clicked to Center’ option is checked, the image zooms in centered around the point where you click, and the best way to understand the distinction between having this option on or off is to see what happens when you click to zoom in on the corner of a photo. When checked, the corner point of the photo will keep recentering as you zoom in.

**Touch interactions on Windows**

Windows OS computers that feature touch screens such as the Microsoft Surface 3 and Surface Pro 3 computers are supported by Photoshop. Work has been done to enhance the touch interaction on the canvas. Along with the existing two-finger gestures for manipulating the canvas view transformation, gestures have been added for moving back and forth through the document history states, and for cycling between the three screen modes. The existing gestures plus new ones are listed in Figure 23.

**Modifier keys palette**

Windows touch devices will also benefit from a Modifier Keys palette that lets you quickly access the Shift, Ctrl, and Alt keyboard modifiers. This palette is available from the Window menu and by default docks to the left of the Toolbar panel (although you can dock it anywhere you like).
<table>
<thead>
<tr>
<th><strong>Existing gestures</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two-Finger Pan</td>
<td>The canvas view may be panned by moving two fingers in any direction on the canvas without changing the distance between them or the angle of the line connecting them.</td>
</tr>
<tr>
<td>Two-Finger Pan and Zoom</td>
<td>The canvas view may be panned and zoomed by moving two fingers toward or away from each other.</td>
</tr>
<tr>
<td>Two-Finger Pan and Rotate</td>
<td>The canvas may be panned and rotated by rotating two fingers around the center of the line connecting them.</td>
</tr>
<tr>
<td>Two-Finger Free Transform</td>
<td>To apply a free transform, rotate two fingers around the center of the line connecting them while simultaneously moving them nearer to or further from each other.</td>
</tr>
<tr>
<td>Two-Finger Reset or Restore View</td>
<td>Following on from the above, place two fingers on the tablet surface and keep them motionless for a moment. The canvas view may then be freely panned, zoomed or rotated.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>New gestures</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two-Finger Step Back in History (Undo)</td>
<td>To go back one step in the history, move two fingers rapidly from right to left.</td>
</tr>
<tr>
<td>Two-Finger Step Forward in History (Redo)</td>
<td>To go forward one step in the history, move two fingers rapidly from left to right.</td>
</tr>
<tr>
<td>Three-Finger History Scrub</td>
<td>To move in a continuous fashion through the entire history, move three fingers right or left on the tablet surface.</td>
</tr>
<tr>
<td>Five-Finger Cycle Screen Mode</td>
<td>Tap once with five fingers to cycle through the three application display screen modes (including the full screen mode).</td>
</tr>
</tbody>
</table>

**Figure 23** A summary of gestures available when working with a Windows touch screen-enabled computer.
History Log preferences

The History Log preferences are shown in Figure 24. A history log is useful if you wish to keep track of everything that has been done to an image and the History Log options let you save the history log directly in the image file metadata, to a saved text file stored in a pre-configured folder location, or both. Edit log items can be recorded in three modes. ‘Sessions Only’ records which files are opened and closed and when. The ‘Concise’ mode records an abbreviated list of which tools or commands were applied (also recording times). Both these modes can provide basic feedback that could be useful in a studio environment to monitor the time spent on a particular project and help calculate billing. The ‘Detailed’ mode records everything, such as the coordinates used to make a crop. This mode can be useful, for example, in forensic work.

Figure 24 The History Log preferences.
File Handling preferences

In the File Handling preferences (Figure 25) you will normally want to include image previews when you save a file. It is certainly useful to have image thumbnail previews that are viewable in the system dialog boxes although the Bridge program is capable of generating large thumbnails regardless of whether a preview is present or not. Appending a file with a file extension is handy for knowing which format a document was saved in and absolutely necessary when saving JPEG and GIF web graphics that need to be recognized in an HTML page. If you are exporting for the Web, you may want to check the ‘Use Lower Case’ option for appending files. However, instances of where servers trip up on upper case naming are fairly rare these days. The ‘Save As to Original Folder’ option is useful if you want this to be the default option. It makes sure that you are always able to save new versions of an image to the same folder as the original file came from. If this option is left unchecked, Photoshop shows you the last used folder location when you choose File ➤ Save As…

Economical web saves

There are times though when you don’t need previews. Web graphic files should be uploaded as small as possible without a thumbnail or platform-specific header information. If you use Save for Web, this removes the previews and keeps the output files compact in size.

Figure 25 The File Handling preferences.
‘Save in Background’ is an auto-recovery option that is switched on by default. When checked, Photoshop auto-saves the documents you are working on to a special location using the PSD file format (this is so everything you might add to a file is always included when auto-saving). Should you suffer a crash, the next time you open Photoshop you’ll be given the opportunity to rescue any lost work. Also included below is an ‘Automatically Save Recovery Information’ option, where you can specify how regularly you would like Photoshop to update the recovery file.

**Camera Raw preferences**

If you click on the Camera Raw Preferences… button in the File Compatibility section this will open the dialog shown in Figure 26. At the bottom are the JPEG and TIFF handling preferences where you have three options with which to decide how JPEG and TIFF images should be opened. The background story to all this is that

![Figure 26](image)

*Figure 26* The Camera Raw preferences dialog with the JPEG and TIFF handling options at the bottom.
Photoshop CS3 allowed for the first time for JPEG and TIFF images to open via Camera Raw, as if they were raw files. A number of people had misgivings about this, partly because of the potential confusion it might cause, but also because of the way it was implemented in Photoshop at the time. For example, you had the Photoshop File Handling preferences doing one thing plus another setting in the Bridge preferences and there was no simple way to summarize how these should be configured in order to get JPEG or TIFF images to open up via Camera Raw the way you expected. In fact, even fellow Photoshop experts were just as confused as everyone else as to how to manage the preference settings in these two different locations. To be honest, it was a bit of a mess, but things have been improved somewhat since then.

The Camera Raw preferences options are now fairly easy to understand and predictable in their behavior. If ‘Disable JPEG (or TIFF) support’ is selected this safely takes you back to the way things were before, where all JPEG or TIFF files open in Photoshop directly. If ‘Automatically open all supported JPEGs (or TIFFs)’ is selected, this causes all supported JPEGs (or TIFFs) to always open via Camera Raw. However, if ‘Automatically open JPEGs (or TIFFs) with settings’ is selected, Photoshop only opens JPEG or TIFF images via Camera Raw if they have previously been edited via Camera Raw. When this option is selected you have the option in Bridge to use a double-click to open a JPEG directly into Photoshop, or use \( \text{Cmd} + R \) (Mac), \( \text{Ctrl} + R \) (PC) to force JPEGs to open via Camera Raw. Note that when you edit a JPEG or TIFF in Camera Raw in this way, the next time you use a double-click to open, the file will now default to opening via Camera Raw.

So why should you want to open JPEGs (or TIFFs for that matter) in Camera Raw? This is useful if you shoot in JPEG mode and wish to use Camera Raw to process the JPEG masters (as you would a raw capture image) without actually editing the master files. This is because Camera Raw records all the edits as separate instructions. The same argument applies to opening TIFF files via Camera Raw, but the important thing to note here is that Camera Raw can only open flattened TIFFs and cannot open TIFFs that contain saved layers. The main reason why it might be useful to use Camera Raw to open a TIFF image is if you want to process TIFF scan images via Camera Raw to take advantage of things like the capture sharpening controls in the Detail panel section. Note that Photoshop CC does now offer an Adobe Camera Raw filter in the Filter menu, so it is now much easier to edit almost any Photoshop image (or individual layer) using the Camera Raw filter, providing it is in RGB or Grayscale mode. The Camera Raw chapter in the book shows an example of a typical Camera Raw filter workflow.
File compatibility

Back in the main Photoshop File Handling preferences dialog, the ‘Prefer Adobe Camera Raw for Supported Raw Files option’ always launches Adobe Camera Raw as your favored raw processor when opening a proprietary raw file. Below this is ‘Use Adobe Camera Raw to convert documents from 32 bit to 16/8 bit.’ This allows you to elect opening Camera Raw as a filter (and use the Version 3 or Version 4 Basic tone controls to tone edit) when you choose to convert from 32-bit to 16 or 8-bits per channel.

Some cameras may embed an sRGB profile tag in the EXIF metadata of a JPEG capture file (where the profile used isn’t a correct sRGB profile anyway). If you check the ‘Ignore EXIF Profile Tag’ option, Photoshop ignores this particular part of the metadata and reads from the (correct) embedded profile data instead. The ‘Ignore Rotation Metadata’ option allows you to ignore any rotation settings applied via Camera Raw and will open such files without any rotation.

Saving layered TIFF files

A TIFF format file saved in Photoshop 6.0 or later can contain all types of Photoshop layer information and a flattened composite is always saved in a TIFF. If you then place a layered TIFF image in a page layout, only the flattened composite will be read by the program when the page is finally converted to print. Some people argue that there are specific instances where a layered TIFF might trip up a print production workflow, so it might be safer to never save layers in a TIFF, but you know, there are a large number of Photoshop users who successfully use layered TIFFs when saving master images. My advice is not to be put off including layers. When the ‘Ask Before Saving Layered TIFF Files’ option is checked, Photoshop presents you with an option to either flatten or preserve the layers when saving a layered image as a TIFF. If this is unchecked, then the layer information is saved regardless and you’ll see no warning dialog.

Photoshop (PSD) file compatibility

Standard Photoshop PSD files created in Photoshop CC won’t be 100% compatible if they are likely to be read by someone who is using an earlier version of Photoshop and this has always been the case with each upgrade of the program. Setting the Maximize PSD and PSB Compatibility to ‘Always’ allows you to do the same thing as when saving a flattened composite with a TIFF. This option ensures that a flattened version of the image is always included with the saved Photoshop file and the safe option is to keep this checked. For example,
if you include a Smart Object layer, the Photoshop file will not be interpreted correctly when read by Photoshop CS or earlier unless you maximize the compatibility of the saved PSD. In these circumstances if Photoshop is unable to interpret an image it will present an alert dialog. This will warn that certain elements cannot be read and offer the option to discard these and continue, or to read the composite image data. Discarding the unreadable data allows another user to open your image, but when opened it will be missing all the elements you added and most likely look very different from the file you intended that person to receive. If on the other hand they click the ‘Read Composite Data’ button and a composite was saved, the image will open using a flattened composite layer which looks the same as the image you created and saved. If no composite was created, they will just see a white picture and a multi-language message explaining that no composite data was available.

Maximizing PSD compatibility lets images load quicker in Bridge and another crucial factor is that Lightroom is only able to read layered PSD files that have this option turned on. If there is no saved composite, Lightroom won’t be able to import it.

If you set the preference here to ‘Ask’, Photoshop will display a “Don’t show this message again” message in the Maximize Compatibility warning dialog, which will appear after you choose to save an image using the PSD file format (See Figure 27). If the Maximize Compatibility option is checked, the default from now on will be to ‘Always’ maximize compatibility. If the option is unchecked, it will be set to ‘Never’ from now on.

Figure 27 The Photoshop Format Options dialog.
Layered PSD files in a DTP layout

Adobe InDesign allows you to place Photoshop format (PSD) files in a page layout, but if you do so, the Maximize Backwards Compatibility option must be checked in the File Handling preferences (in order to generate a flattened composite). If you use layered TIFF, PSD (or Photoshop PDF) files in your page layout workflow, you can modify the layers in Photoshop and the page design image preview will immediately be updated. This way you don’t run the risk of losing synchronization between the master image that is used to make the Photoshop edits and a flattened version of the same image that is used solely for placing in the layout. If you want to ‘round trip’ your images this way, TIFF is the more universally recognized file format. The downside is that you may end up with bloated files and these can significantly increase the file transmission times. It so happens that nearly all the image files used in the production of this book have been placed as layered TIFF RGB files, which allows me to edit them easily in Photoshop. Keeping the files as layered RGBs is perfect at the text editing stage, but the final TIFF files that are used to go to press are all flattened CMYK TIFFs.

Disable compression

Lastly, you can choose to ‘Disable Compression of PSD and PSB files’. These file formats normally include a lossless form of compression which helps keep the saved file size down. Disabling this won’t improve the image quality, but may reduce the time it takes to save and will only affect 16-bit or 32-bit images. Having said that, efforts were made in Photoshop CS6 to optimize the read/write times for PSD and PSB files.

Recent File list

The Recent File list refers to the number of image document locations that are remembered in the Photoshop File ➤ Open Recent submenu. You might want to set this to the maximum limit allowed which is now 100.
Export preferences

The Export preferences dialog is shown in Figure 28. These settings link to the Export options behavior. The Quick Export Format section affects what happens when you choose File ⇨ Export ⇨ Quick Export as… Use the menu here to select the file format you want to use when carrying out a quick export. So for example, if PNG is selected (as shown in Figure 28), the Save for Web submenu will say ’Quick Export as PNG’, and there is an option next to this in the Export preferences to include transparency or not, or save as a smaller, 8-bit version.

The Quick Export Location section lets you determine where the exported files should be saved to. If ’Ask where to export each time’ is selected, you’ll see a system navigation services dialog appear each time, asking where you would like to save the exported file to. Alternatively, you can choose ’Export files to an assets folder next to the current document’. When selected, this automatically creates an assets folder alongside the master image (wherever it is located) and saves the exported file(s) there. The Metadata section can be used to determine what metadata is saved: either None, or Copyright and Contact Info. In the Color Space section I advise you select the Convert to sRGB option to include an embedded profile when creating a quick export.

Figure 28 The Export preferences dialog.
Performance preferences

The Performance preferences section (Figure 29) can be used to configure Photoshop to run efficiently on your computer. The memory usage can be set using a sliding percentage scale and you will notice how Photoshop provides a hint as to what the ideal range should be for your particular computer.

Memory usage

The amount of RAM memory you have installed determines how efficiently you can work in Photoshop. Each time you launch Photoshop a certain amount of RAM memory is set aside for use by the program. How much depends on the amount that is set in the Memory Usage section, expressed as a percentage of the total amount of RAM that is available for Photoshop to use. The figure you see in the Memory Usage section is just the RAM that’s reserved for

Figure 29 The Performance preferences.
Photoshop (although the RAM you set aside for Photoshop can be shared by other applications when it is not actively being used by Photoshop). Adobe recommend you allocate a minimum of 1 GB RAM memory, which means that if you allow an additional 200 MB of RAM for the operating system, you will need to have at least 2 GB of RAM installed. If you also take into account the requirements of other programs and the likelihood that newer operating systems may need even more memory, it is safer to suggest you actually need a minimum of 4 GB RAM memory in total. Don't forget that you will also need to allow some RAM memory to run Adobe Bridge at the same time as Photoshop. But in any case, most computers sold these days come with at least 4 GB of RAM.

The Memory Usage section therefore provides a guide for the ideal RAM setting for your computer and indicates what the ideal range should be. On a Windows system the default setting is 50% of the total available RAM and on a Mac it is 70%. If the memory is set too high Photoshop may end up competing with the operating system for memory and this can slow performance, although as I mentioned earlier, the memory assigned to Photoshop is freed up whenever Photoshop is not running. You can always try allocating 5% above the recommended upper limit, relaunch Photoshop and closely observe the efficiency status bar or Info panel Efficiency readout (Figure 30). Anything less than 100% indicates that Photoshop is running short of physical memory and having to make use of the scratch disk space. If you allocate too high a percentage, this can compromise Photoshop’s efficiency. So the trick is to find the optimum percentage before you see a drop in performance.

**32-bit and 64-bit RAM limits**

The amount of RAM that is available to Photoshop is obviously dependent on the total amount of RAM memory that’s installed on your computer. If you run Photoshop on a Windows computer with a 32-bit operating system that has 4 GB or more of RAM installed, a maximum of 3 GB of RAM can be allocated to Photoshop. Even if you are hit by the 4 GB RAM limit on a 32-bit system and you have more than 4 GB memory installed, the RAM above 4 GB can also be used by the operating system as a cache for the Photoshop scratch data. So although you can’t allocate this extra memory directly, installing extra memory can still help boost Photoshop’s performance on a 32-bit system.
Providing you have the latest 64-bit enabled hardware and a 64-bit computer operating system, you can install or run Photoshop in 64-bit mode. In fact, Macintosh users can now only install a 64-bit program and must therefore be using a 64-bit enabled Macintosh to run Photoshop CC. The main advantage 64-bit brings is increased RAM memory access beyond the 4 GB physical limit. In terms of speed you won’t necessarily find a 64-bit version of Photoshop to be that much faster than a 32-bit version, except for when you are working with very large files or carrying out memory-intensive operations.

History & Cache

In the History & Cache section the default number of History States is 50. You can set this to any number you like from 1–1000, but remember that the number of histories you choose will have a bearing on the scratch disk usage.

The Cache Level settings affect the speed of the screen redraws. Whenever you are working with a large image, Photoshop uses a pyramid type structure of lower resolution cached versions of the full resolution picture. Each cached image is a quarter scale version of the previous cache level and is temporarily stored in memory to provide speedier screen previews. Basically, if you are viewing a large image on screen in ‘Fit to screen’ display mode, Photoshop uses a cache level that is closest to the fit to screen resolution to provide a screen refresh view of any edit changes you make at this viewing scale. The cached screen previews can therefore provide you with faster screen redraws and larger images can benefit from using a higher cache level, since a higher setting provides faster screen redraws, but at the expense of sacrificing the quality of the preview. This is because a lower resolution cache preview is not as accurate as when viewing an image at an ‘actual pixels’ view.

The optimization buttons can help you set the Cache Levels to an appropriate value. If you mostly work on small images such as Web design layouts, which are small in pixel dimension size, but may contain lots of complex layers, you’ll gain better performance by clicking the ‘Web/UI Design’ button to set the Cache Levels to 2. If you mostly work with large images, but not quite so many layers, you can click on the ‘Huge Pixel Dimensions’ button to set the Cache Levels to 6, although you may wish to override this and set the cache levels even higher than this. Photoshop CC analyzes the images you typically edit and after the first 5 launches auto-sets the Cache setting based on the images you recently had opened in Photoshop. Therefore, if you

---

**RAM memory upgrades**

Most PCs and Macs use DIMMs (Dual In-line Memory Modules). The specific RAM memory chips may vary for each type of computer, so check carefully with the vendor that you are buying the right type for your particular machine. RAM memory used to cost a small fortune, but these days the price of RAM is almost inconsequential. If you have four RAM slots on your machine, you should easily be able to install 4 × 4 GB RAM or 4 × 8 GB RAM memory chips, which will give you 16 or 32 GB of installed RAM. A good suggestion is to install an absolute minimum of 1 GB of RAM per processing core on your computer, while the ideal balance is more like 2 GB of RAM per core. If you aim for 4 GB of RAM per core, you will see significant benefits with certain memory-intensive filter operations. For all other types of operations the speed benefits are not quite so dramatic.
If you happen to have worked on a series of photos that were unusually large or small, you may want to check the Performance preferences to see if the cache setting needs to be reset.

The Cache Tile Size can be adjusted according to what is the most appropriate setting for the type of work you do. The Cache Tile Size can be set anywhere from 128K–1024K, and tests suggest the optimum settings to choose from are 128K/1024K for the newer Intel processors and 132K/1028K for AMD processors. For image editing work with large photo-sized documents where throughput, i.e. image size, is more of a consideration, it is better to choose a larger Cache Tile Size here.

**Cache tile size and batch processes**

There are certain types of Photoshop operations (such as a Radial Blur filter) that can make heavy demands on the computer hardware, utilizing nearly all of your processors. If you raise the cache tile size in the Performance preferences to 1024 or 1028K this means the data to be processed is divided into bigger chunks and this in turn can make a big improvement to batch processing times. The optimum choice of tile size here will depend on whether you are using an Intel or AMD processor.

**Cache pyramid structure**

If you have the Use Graphics Processor option switched off, or your video card does not support OpenGL, you may sometimes notice how layered Photoshop images are not always displayed with complete accuracy at anything other than the 100% magnification. For example, if you have added a pixel layer that has a sharp edge, you might see a line appear along the edges when it is viewed at smaller viewing percentages. This is simply the image cache speeding up the display preview at the expense of accuracy. If you have to work on an image (without OpenGL) at a less than 100% magnification, then do make sure the magnification is a wholly divisible number of 100%. In other words, it is better to work at 50%, 25% or 12.5% magnification, rather than at 66% or 33%. Note also that the number of cache levels will affect the structure of a TIFF file when the ‘Save Image Pyramid’ option is selected.

**Graphics Processor settings**

The Graphics Processor Settings let you enable the graphics processor if your video card allows it, while the History & Cache section includes Cache levels plus Cache Tile Size options and buttons to help you configure the ideal cache/tile settings.
As I mentioned earlier in this chapter, OpenGL/OpenCL enabled video cards are able to offload processor-intensive activity from the CPU to the video card’s GPU (Graphics Processing Unit). Such a card will also use its own onboard RAM to lessen the burden on the CPU and this can result in faster overall video and specific processing performance. Photoshop is able to detect the graphics card used by your computer and whether it has a built-in Graphics Processor Unit (GPU) capability. If so, you can then check the ‘Use Graphics Processor’ option to make full use of the graphics processor memory on the card. This preference setting affects images opened in Photoshop on a per-window document basis.

The main advantages of enabling the graphics processor are: smooth views when using odd number viewing percentages, smooth image rotation, flick panning, smooth animated zooms, the bird’s-eye view zoom-out feature, Puppet Warp, applying transforms plus a pixel grid display at view magnifications greater than 500%. In Photoshop CS6 and later, 16-bit and 32-bit images should also redraw faster when viewed at a 50% magnification or lower. And, where cards are OpenCL enabled, this can improve performance when using the Blur Gallery filters in Photoshop. However, the advanced graphic processing is only available on later operating systems (which are basically the ones that are required anyway to run Photoshop CS6 and later).

If you click on the Advanced Settings… button this opens the Advanced Graphics Processor Settings dialog shown in Figure 31, where you will want to check ‘Use Graphics Processor to Accelerate Computation’ option. There are three Drawing Mode levels: Basic,
Normal and Advanced. The Advanced option aims to give you the maximum benefit from the graphics processing, but if the screen redraws appear to work less smoothly than desired you can select the Normal or Basic modes instead. Checking the Anti-alias Guides and Paths option can help improve the visibility of pen paths and guides. Mac users working with the latest iMacs and Mac Pro computers running macOS 10.12 or later can enable 30-bit display support. The ‘Use native operating system GPU acceleration’ option enables use of macOS Metal and Windows DirectX 12 as appropriate. So far this can be used to accelerate the Oil Paint Filter, but more items in Photoshop may benefit in the future. If the option appears grayed out it means your system’s GPU doesn’t meet the GPU model or driver version requirements.

Mercury graphics support

There is expanded Mercury Graphics Engine support in Photoshop CC. This allows Photoshop to upsample images via the Image Size dialog, up to 15 times faster than earlier versions of Photoshop, though this does depend on the file size and video card used. This graphics performance boost helps speed up things like the Blur Gallery filter effects and the Focus Mask feature.

Speed and efficiency test

To help evaluate the performance efficiency of your computer setup, here is a really useful weblink to a site hosted by a company called Retouchartists.com: retouchartists.com/pages/speedtest.html. From there you can download a test file which contains a sample image and a Photoshop action that was created by Alex Godden. All you have to do is time how long it takes for the action to complete to gauge and compare how fast your computer is running. You can then compare your speed test results with those of other Photoshop users.
Scratch Disks preferences

Photoshop can utilize the free hard disk space that’s allocated in the Performance preferences (Figure 29) as an extension of RAM memory. Photoshop always makes the most efficient use of the real RAM memory and tries to keep as much RAM as possible free for memory-intensive calculations. Low-level data like the 'last saved' version of the image is stored in the scratch disk memory giving priority to the current version and last undo versions being held in RAM. Normally, Photoshop uses all the available free RAM as buffer memory in which to perform real-time calculations and mirrors the RAM memory contents on the scratch disk. Photoshop does this whenever there is a convenient opportunity to do so. For example, after you open a new image you may notice some disk activity as Photoshop writes from the RAM memory buffer to the scratch disk. Photoshop then continually looks for ways to economize the use of RAM memory, writing to the hard disk in the background whenever there are periods of inactivity. Scratch disk data is also compressed when it is not in use (unless an optional plug-in extension that prevents this has been loaded at startup). The Scratch Disk preferences (Figure 32) can be used to check which volumes are used as scratch disks. You can highlight a particular disk, then use the arrows to move it up or down the scratch disk priority list.

![The Scratch Disk preferences.](image)

Figure 32 The Scratch Disk preferences.

**Restart to activate preferences**

The Scratch Disk preference settings in the Scratch Disk preferences only come into effect after a restart.
When you launch Photoshop it checks to see how much hard disk space is free for scratch disk usage and if for any reason you have less scratch disk space than RAM memory space, the RAM memory will be restricted by the amount of scratch disk space that is available. When Photoshop exhausts its reserves of RAM memory, it is forced to use the extra space on the scratch disk as a source of virtual memory and this is where you will start to see a major slowdown in efficiency. When the Efficiency indicator (Figure 30) drops below 100% this means that the RAM buffer is full and Photoshop is now relying exclusively on the hard disk scratch disk space as a memory reserve. This is because the Photoshop calculations are limited to the read/write speeds of the primary scratch disk, followed by the secondary disk, and so on. Should you experience a temporary slowdown in performance you might want to purge Photoshop of any excess data that’s temporarily held in memory. To do this, choose Edit ⇒ Purge and select Undo, Clipboard, Histories or All.

The primary scratch disk should ideally be one that is separate to the disk that’s running the operating system and Photoshop. It is no good partitioning the main disk volume and designating an empty partition as the scratch disk, because the disk drive head will simply be switching back and forth between different sectors of the same disk as it tries to do the job of running the computer system and provide scratch disk space. For optimal image editing, you ideally want the scratch disk to be a fast, separate disk volume with a minimum of 20–40 GB of free space and as free as possible of any disk fragmentation. Having said that, with the latest SSD drives there are no moving parts. They are also very fast compared with normal hard drives and it is possible to partition a main SSD hard drive, allocating a portion of this as a scratch disk. If you hold down the ⌘ (Mac), Ctrl Alt keys during startup, this opens the dialog shown in Figure 33, allowing you to set the preferred scratch disk at launch.

**Scratch disk performance**

With all this reliance on the scratch disk (or multiple scratch disks) to read/write data from the RAM memory buffer, the hard disk performance of the scratch disk plays an important role in maintaining Photoshop efficiency. There is provision in Photoshop for as many as four scratch disks. Each individual scratch file created by Photoshop can be a maximum of 2 GB and Photoshop can keep writing scratch files to a scratch disk volume until it becomes full. When the primary scratch disk runs out of room to accommodate all the scratch files during a Photoshop session, it then starts writing scratch files to the secondary
scratch disk, and so on. This makes for more efficient and faster disk usage. Let’s now look at the important factors that affect the speed of the scratch disk.

**Scratch disk usage and history**

The scratch disk usage will vary according to how many history states you have set in the History and Cache section and also how you use Photoshop. Generally speaking, Photoshop stores a version of each history state, but it does not always store a complete version of the image for each history state. The History feature only needs to save the changes made in each image tile. So if you carry out a series of brush strokes, the history only stores changes made to the altered image tiles. For this reason, although the scratch disk usage increases as you add more history steps, in practice the usage does not increase in such large chunks, unless you were to perform a large series of global changes.

**Interface connection**

Most modern Macs and PCs have IDE, ATA or SATA drives as standard. A fast internal hard disk is adequate for getting started, but for better performance, you should really install a second internal or external hard drive and have this dedicated as the primary scratch disk (make this the number one scratch disk in the Performance preferences). Your computer will most likely have the choice of a USB and/or FireWire connector for linking external devices. USB 2 and USB 3 offer fast connection speeds and FireWire (IEEE 1394) remains reasonably fast. With USB or Firewire you can hot swap a drive between one computer and another. This is particularly useful when you wish to shuttle very large files around quickly. The latest Macintosh computers now feature a Thunderbolt interface capable of transfer rates up to 500 Gbits/s. Note though that it is the data transfer and not the data access time that is the measure of disk speed to look out for.

**Hard drive speed**

Most desktop computers use internal drives which run at 7200 rpm and you can easily find spare internal drives that run at this speed or faster. Laptop computers usually have slower hard drives fitted as standard (typically 5400 rpm). It may therefore be worth checking if you can select a faster speed hard drive as a build-to-order option. These days SSD drives are more likely to be offered as standard, and are much faster than regular hard drives. These have no moving parts and you can therefore partition a single SSD drive to use one partition as a scratch disk. Some computers can also be configured using fusion drives that are a hybrid of standard hard drive and SSD.
drive technology. External SATA drives (eSATA) are now regarded as faster than Firewire 800 and are available, sometimes as multiport drives like the LaCie d2 series. In theory these are better.

RAID setups

RAID stands for Redundant Array of Independent Disks, and a simple way to explain RAID is that it allows you to treat multiple drives as a single drive volume to provide either increased data integrity, capacity, transfer rates or fault-tolerance compared with a single volume. How it does this depends on the RAID level you choose. You need a minimum of two disks to configure a RAID system and most off-the-shelf RAID solutions are sold as a bay dock that can accommodate two or more drives with a built-in RAID controller. A RAID disk can be connected via internal SATA or using a fast external interface connection.

**RAID 0 (striping)**

A RAID 0 setup is suitable for use as a Photoshop scratch disk. With a RAID 0 setup, two or more drives are striped together to create a single large volume drive. For example, if two 400 GB drives are striped using a RAID 0 setup you will end up with a single 800 GB volume. RAID 0 is useful where you require fast hard drive access speeds, because the drive access speed increases proportionally to the number of drives that are added. So, if you have a 2 x 400 GB drive RAID 0 system, the hard drive access speed should theoretically be two times that of a single 800 GB drive. A RAID 0 setup can offer faster speeds, but will be less reliable, since if one drive fails, all the stored data is lost on the combined volume, which is why I recommend this configuration mainly for scratch usage.

**RAID 1 (mirroring)**

A RAID 1 setup stores duplicate data across two drives. This means that if you have, say, two 400 GB drives configured in a RAID 1 setup, the data on one drive is mirrored on the other and the total drive capacity will be equal to that of a single drive (in this case, 400 GB). RAID 1 systems are used as a way to protect against sudden drive failure since if one drive fails, a mirror copy of that data can immediately be accessed from the other drive and if you replace the defunct drive with a new one, the RAID 1 system rebuilds a copy of the data on the new drive. A RAID 1 setup offers greater security but the downside is that RAID 1 read/write speeds are slower. This is because the RAID 1 system has to constantly back up the data between one drive and the other.
Internal RAID

You can fit an internal RAID system with a do-it-yourself kit consisting of two internally mounted drives and a RAID controller card. This should not be too challenging to install yourself, but if you are in any doubt about whether you are capable of doing this then you should get a qualified computer specialist to install such a system in your computer. The advantage of an internal RAID is that it is always there whenever you turn the computer on and is an economical solution compared with buying an external RAID drive setup. Most PC tower computer systems should have plenty of free hard drive bays, which will make it fairly easy for you to install internal RAID. An internal RAID setup will definitely speed up the time it takes Photoshop to read and write data to the scratch disk. However, if you have more hard drives running simultaneously this will mean more power consumption, which in turn can generate extra heat and possibly more noise too. Be warned that this heat may cause problems for the cooling system in your computer and put extra strain on the internal power supply unit.

External RAID

External RAID hard drive units (Figure 34) are not overly expensive and you can easily buy a ready assembled bay dock with a couple of drives and a built-in RAID controller that can be configured for RAID 0. The speed will be governed not just by the number of drives making up the RAID but also by the speed of the cable connection. Most RAID systems these days will connect to the computer via a FireWire 400/800, USB 3 or SATA connection, which may again require a special card in order to connect to the computer (for now). Regarding the Mac OS X system. The latest Macs now rely on Thunderbolt, where the interface is suitably fast for a high speed RAID setup.

Software RAIDs

It used to be the case that software-created RAIDs such as the one included with the Mac OS X Disk Utilities program were a lot slower than a dedicated system. True, the read/write speeds from a software RAID will still be somewhat slower than a true dedicated RAID system since a software RAID will be stealing some of your computer processor cycles, but these days the speed loss is not as bad as it used to be. For example, a software-driven internal striped RAID 0 can bring about a 45% increase in disk access speed. Overall I recommend that if you do choose to go down the internal RAID route, you use a dedicated device with a RAID controller.
Cursors preferences

We now come to the Cursors preferences (Figure 36). The painting cursors can be displayed as a painting tool icon, a precise crosshair or with the default setting, which shows an outline of the brush shape at its ‘most opaque’ size in relation to the image magnification. When the Normal brush tip is selected, the brush cursor size represents the boundary of the brush shape up to where the brush opacity is 50% or denser in opacity. You can also choose to display a Full Size brush tip, indicating the entire outer edge reach of a soft edged brush. This represents the complete brush area size and it is debatable whether this improves the appearance of the painting cursors or not (Figure 35). The ‘Show Crosshair in Brush Tip’ option displays a crosshair inside the brush size cursor. Or, you can choose to only show the crosshair. The ‘Show Brush Leash While Smoothing’ option helps when increasing the Smoothing setting to help indicate where you are dragging. In the Other Cursors section, the Standard option represents all the other tools using a standard tool icon. I suggest you change this to the Precise setting, because this will make it easier for you to target the placement of certain tools such as the Crop tool or Clone stamp.

Figure 35 This is an example of the brush cursor using the Full Size Brush Tip mode with Show Crosshair in Brush Tip.

Figure 36 The Display & Cursors preferences.
The *Caps Lock* key can be used to toggle the cursor display. When the Standard paint cursor is selected, the *Caps Lock* toggles between a Standard and Precise cursor view. When the Precise or a brush size paint cursor option is selected, the *Caps Lock* toggles between a Precise and a brush size cursor view. When the Standard cursor mode is selected for all other cursors, the *Caps Lock* toggles between the Standard and Precise cursor views.

### Transparency & Gamut preferences

The Transparency & Gamut preferences (Figure 37) let you configure how the transparent areas in an image are represented on the screen. If a layer contains transparency and is viewed on its own with the background layer visibility switched off, the transparent areas are normally shown as a checkerboard pattern. The Transparency Settings let you decide how the checkerboard grid size and colors are displayed. You have a choice of Transparency display settings: None, Small, Medium or Large grid pattern, and a choice of different grid colors. If you go to the preferences shown here you can select different grid sizes and colors, but you can also select None. When this is selected the transparent areas are displayed as solid white.

![Figure 37 The Transparency preferences.](image_url)
**Color Picker gamut warning**

The gamut warning can be switched on via the View menu (⌘ Shift Y [Mac], Ctrl Shift Y [PC]) and uses whatever color has been set in the Transparency & Gamut preferences. The gamut warning alerts you to any colors that will be out of gamut after a conversion is made from, say, RGB to CMYK, or whichever color space is currently loaded in the View ⇒ Proof Setup menu. The default overlay color is a neutral gray at 100% opacity, but I suggest reducing the opacity to make the gamut warning appear as a semi-transparent overlay. So, if you are working on an image in RGB mode and you choose View ⇒ Gamut Warning, Photoshop highlights these out-of-gamut colors with a color overlay. The gamut warning is, in my view, a rather crude instrument for determining whether colors are in gamut or not, since a color that is only slightly out of gamut will be highlighted as strongly as a color that is hugely out of gamut. A good quality graphics display coupled with a custom proof setup view mode is a much more reliable guide. Note that if you have the Photoshop Color Picker dialog open, you can choose View ⇒ Gamut Warning to apply a gamut warning overlay to the Color Picker colors (see Figure 38).

![Figure 38 This shows the Photoshop Color Picker with a gamut warning applied.](image)
Units & Rulers preferences

You can use the Units & Rulers preferences section (Figure 39) to set the Ruler measurements (inches or centimeters, etc.) and the units used. As well as using the preferences options shown here, the measurement units can also be changed via the Info panel submenu or by Ctrl (Mac), right mouse-clicking (PC) on a ruler to open the contextual menu (you can also double-click the ruler bar as a shortcut for opening the Units & Rulers preferences).

The New Document Preset Resolution options let you decide what the default pixel resolution should be for print output or screen display work whenever you select a preset from the File ➤ New Document dialog. The Screen Resolution has typically always been 72 ppi. But

![Figure 39](image.png) The ruler units can be set in pixels, inches, cm, mm, points, picas or as a percentage. The percentage setting is ideal for recording actions that you wish to apply proportionally at any image size.
there is no real significance to the resolution that is set here if an image is only destined to appear in a Web page design. Web browser programs are only concerned with the physical number of pixels an image has and the resolution setting actually has no relevance. The Print Resolution setting is more useful as this does have an important bearing on what size an image will eventually print.

**Guides, Grid & Slices preferences**

The Guides, Grid & Slices preferences are shown in Figure 40. These let you choose the colors to use for the Guides, Smart Guides, Grid and Slices. Both Grid and Guides can be displayed as solid or dashed lines, with the added option of dotted lines for the Grid. The number of Grid subdivisions can be adjusted to suit whatever project you are working on and the Slice options include a Line Color style and whether the Slice Numbers are displayed or not.

The Path section can be used to adjust the default path color and thickness. However, it is easier to just click on the Gear wheel icon on the Pen tool Options bar to edit these preference options.

![Figure 40 The Guides, Grid & Slices preferences.](image-url)
Smart Guides in Photoshop CC

Smart Guides are enabled by default in Photoshop CC and you will notice how reference guides appear that call out the distance between the current selected object and a referenced object. This distance is calculated based on the distance between the object bounding box rectangles, rather than measuring between the text baselines, or individual path points of a vector shape (see Figure 41). As you move an object, Measurement Guides visually indicate the spacing between the selected object and its immediate neighbors. To disable Smart Guides go to the View menu, select Show ➤ Smart Guides and check to turn off.

Smart Guides modifier key behavior

If you hold down the `Alt` key as you drag to duplicate a layer or text layer using the move tool, or duplicate a vector shape using one of the path selection tools the reference measurement guides will show the distance between the duplicate object and the original (see Figure 42 and Figure 43).

Figure 42 In this example, I held down the `Alt` key as I dragged the selected Layer 1 layer. This made a duplicate of the layer and a Smart Guide appeared to indicate the distance apart for this and the original layer.

Figure 43 In this example I created a vector shape layer and held down the `Alt` key as I dragged to create a duplicate of the shape. The Smart Guide indicated the distance moved from the original by the duplicate.
If you select a layer and hold down the ⌘ (Mac) key or ⌘ (PC) as you hover the cursor over another layer this will show the Measurement Guides (see Figure 44 and Figure 45). You can then use the keyboard arrow keys to nudge the selected layer as you do this. In the Figure 44 example I held down the ⌘ key (Mac) or ⌘ key (PC) as I hovered the cursor over the image. The Smart Guides in this instance indicate the distances relative to the current selected object. Here it indicated the distances relative to the document bounds. If I rolled over one of the other layers it would indicate the distances relative to the selected object.

**Figure 44** In this example I held down the ⌘ key (Mac) or ⌘ key (PC) as I hovered the cursor over the image.

**Figure 45** In this example I had duplicated a vector shape and held down the ⌘ key (Mac) or ⌘ key (PC) as I hovered the cursor over the image. This indicated the gap distance between the bounding boxes of the two objects.”
**Matched Spacing**

When you move an object, such as a layer, Measurement Guides will visually indicate the spacing between this layer and other layers where the spacing matches. These Measurement Guides will suddenly pop up as you move the layer (or other object) just within range of the same measured distance as the other objects (see Figure 46 below).

![Figure 46](image)

As you move an object closely within range of a similar measured distance to two or more other objects, you will see matched spacing Measurement Guides appear as shown here.

**Show menu options**

The View ➔ Show menu options (Figure 47) allows you to choose which Guides, Grid, or Slices items will be visible.

![Figure 47](image)

The Smart Guides option is useful as a visual aid for aligning layer elements. The Smart Guides (shown here in pink) will flash on and off to indicate when a layer element is aligned to other layers in the image.
Plug-ins preferences

The Plug-ins preferences are shown in Figure 48. When the Generator feature is enabled in Photoshop CC you can use layer naming to automatically generate and update image assets on-the-fly as you edit a document. To enable this, check the 'Enable Generator' box. Be aware though that when this option is enabled, it can slow down Photoshop performance, so you are advised to use the Plug-ins preferences to manage its use.

Adobe have created apps for devices that allow you to interact with Photoshop via a tablet or mobile phone. One such example is the Adobe Nav app that is kind of like a Configurator panel that works on devices. To enable, check the ‘Enable Remote Connections’ option. Having done that, enter a service name and password. You can also access the Plug-ins preferences by going to the Edit menu and choosing Remote Connections… Once you have done this launch the app on your device and login using the same service name and password.

Figure 48  The Plug-ins preferences.
Filters & Extension panels

In the Filters & Extensions Panels section the ‘Show all Filter Gallery groups and names’ option is left switched off. When checked, this lets you see the full range of non-GPU effects filters. I suspect most photographers will be happy to leave this option disabled.

Photoshop can install what are known as extensions panels. If the ‘Load Extensions Panels’ option is checked this loads the installed panels on start-up. Furthermore, if the ‘Allow Extensions to Connect to the Internet’ option is checked, this allows such panels to connect over the Internet, allowing them to access new content plus any important panel updates. This is obviously essential for those extensions panels that need to be connected online in order for them to work. It should be pointed out here that the extension panels Adobe shipped initially all used Flash, which Photoshop no longer supports, so these have currently been discontinued. The fact that this preference remains available suggests some may be revived at some point. So far the Adobe Color Themes panel (formerly Kuler), has made a return to Photoshop.

Third-party Plug-ins

There used to be an option to select the location of an additional plug-ins folder. You’ll notice that this has now been removed, mainly because it’s presence tended to lead to more problems than it was worth. This could sometimes lead to program instability and crashes that could result from pointing to such a plug-ins folder.

The Adobe Photoshop CC Application Plug-ins folder is now used for placing third-party plug-ins, extension panels, or any optional plug-ins that have been distributed outside the full installer. This means you can now more easily disable loading all the plug-ins that are in the Plug-ins folder on a per session basis. To do this hold down the Shift key at launch. This will show a message asking if you would like to skip loading optional and third-party plug-ins.
The Type preferences are shown in Figure 49 and are mainly of importance to graphics users rather than photographers. We could all do with smart quotes I guess, but the smart quotes referred to here is a preference for whether the text tool uses vertical quotation marks or rounded ones that are inverted at the beginning and end of a sentence. The ‘Enable Missing Glyph Protection’ option switches on automatic font substitution for any missing glyph fonts (those swirly graphic font characters). The ‘Show Font Names in English’ option will be of more significance to non-English language users, as it allows them the option to display the font names in English, as an alternative to their own native language. You will notice that in Photoshop the font list uses a WYSIWYG menu listing (Figure 50).

Type tool initialization

When you select the Type tool for the first time during a Photoshop session, there will be a brief pause in which Photoshop initializes the type tool engine. If the Type tool was selected when you last closed Photoshop, the initialization will happen during the start-up cycle.
Enhanced Control preferences (Mac)

The Enhanced Controls Preferences (Figure 51) contain a single option to 'Show Touch Bar property adjustments'. When this is enabled, Mac users with a Touch Bar display, such as on the latest MacBook Pro computers, will see an on-screen display like the one shown in Figure 52 below when making adjustments, such as clicking on the slider to adjust the Hardness setting for a paint tool in Photoshop.

![Preferences](image)

**Figure 51** The Enhanced Controls preferences.

![Touch Bar](image)

**Figure 52** The Mac Touchbar and on-screen display during mid-adjustment.
Technology Previews preferences

The Technology Previews preferences section (Figure 51) is where users can try out new features before they are officially released. In this current release there is an ‘Enable Preserve Details 2.0 Upscale’ item. I discussed this in Chapter 4 of the book demonstrating how with this option checked you can achieve even better interpolation results when using the Preserve Details interpolation option in the Image Size dialog.

![Technology Previews preferences](image)

**Figure 51** The Technology Previews preferences.

**Paint symmetry**

Paint symmetry is supported for the Photoshop paint tools (except the Mixer Brush) and is enabled when the Enable Paint Symmetry option is checked in the Technology Previews preferences. To use, select a paint tool such as the Brush tool. From the Options bar (Figure 52) click on the Paint Symmetry icon (circled) to reveal the Symmetry menu options. Here, you can choose one of the guides from the menu list, or select a current, active pen path. You can also use this menu to turn Symmetry on or off.
After selecting a guide this creates a reflecting plane, or two planes in the case of the Dual Axis example shown in Figure 53. As you paint the brush strokes you apply are reflected in the other plane or planes. Note that bristle tip brushes cannot be used when paint symmetry is enabled. Only regular brush tips will work. While most types of brush strokes are reflected as mirror images it is interesting to paint with Scattering enabled in the Brush Settings. This creates a mirror brush stroke, but with a certain randomness, which you can see in the peach colored brush strokes using the *Scattered Leaves* brush preset.

You can also choose an active path from the Symmetry menu and use this to reflect the brush strokes. You have to watch out if you select a complex path shape. As with the regular Paint Symmetry guides, as you paint Photoshop looks for the closest point on the path to the current mouse cursor. Having done that it reflects the paint stroke across that point on the path. Therefore, gentle curve paths work best. Otherwise things get very complex and lead to unexpected results.

By Martin Evening


768 pages + Online website
Order via Focal Press secure online ordering: www.routledge.com
For more information go to the book website: www.photoshopforphotographers.com